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Documentation Information  
This section describes the conventions and revision history of this document.  

Documentation Conventions  
Icon Conventions 

Icon Description 

Tips  Indicates information that can help you make better use of your product. 

Note Indicates references that can further describe the related topics.  

Caution  Indicates situations that could cause data loss or equipment damage.  

Warning Indicates situations that could cause minor personal injury. 

Danger Indicates situations that could cause major personal injury or even death.  

 

Notation Conventions 

Item  Description 

“ ” 
The quotation marks enclose the name of a software interface element. For 

example, click “OK”.  

Bold  
The text in boldface denotes the name of a hardware button. For example, press the 

PTT key.  

-> 
The symbol directs you to access a multi-level menu. For example, to select “New” 

from the “File” menu, we will describe it as follows: “File -> New”. 
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Revision History  
Version  Release Date  Description  

06(V4.2) 07-2014 

 Added “4.5.2 Upgrade Installation”. 

 Updated description about requirements on version of 

Dispatch station, repeater, radio and Customer 

Programming Software (CPS).  

 Updated “4.2.1 Installing and Configuring the 

Microsoft SQL SERVER 2008 Express”. 

   

05(V4.0) 11-2013 

 Updated the Reset Tracking interface. 

 Added a button in the map toolbar. 

 Updated the Message interface. 

04(V3.6) 01-2013 

 Updated the Reset Tracking interface. 

 Added a button in the map toolbar. 

 Updated the Message interface. 

03 (V3.5) 11-2012  Added the Repeater component.  

02 (V3.0) 09-2012  
Removed the Media Server and Remote Configurator 

components.  

01 (R2.5) 04-2012  Initial release  
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1. Product Overview  
SmartDispatch is an integrated and modular dispatch system based on the Client/Server architecture, 

which facilitates the construction of a complex dispatch system. It consists of the SmartDispatch Client, 

SmartDispatch Gateway, SmartDispatch Server, repeater, dispatch station and radio. SmartDispatch 

provides capabilities such as radio dispatch, GPS location, telephone interconnection, text and voice 

communication, making the dispatching process most efficient. 

 

 

The following table details all components in the SmartDispatch system. 

Network Element  Function  

SmartDispatch Server  Acts as the logical control center in the SmartDispatch system.  

Database  Stores all data of the SmartDispatch system.  

SmartDispatch Gateway  Provides a platform for exchanging data and audios.  

SmartDispatch Client  
Presents all information to the dispatchers in an intuitive manner to 

control, organize and monitor the radio subscribers, groups and fleets.  

Repeater  Extends the communication coverage.  
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Network Element  Function  

Dispatch station  
Expands the dispatch coverage, and provides audio and data 

communication.  

Radio  Fulfills the tasks assigned by the dispatcher.  

Note 

The SmartDispatch Gateway, SmartDispatch Server and SmartDispatch Client can be installed on 

the same computer. If the computer with the SmartDispatch Gateway connects to the dispatch station, 

you should prepare two sound cards at least for it. However, if computer with the SmartDispatch 

Gateway connects to the repeater, you just need to prepare one sound card for it. 

2. Pre-installation Task 
2.1 Software Requirements  
The installation disc (SmartDispatch 4.2) contains all required software programs. See the table below 

for details.  

No. Software  Description  

1 Database  
The installation disc contains the Microsoft SQL SERVER 2008 Express 

and Microsoft SQL SERVER 2005 Express (32-bit). 

2 
SmartDispatch 

Server  

As this application, together with the SmartDispatch Gateway and 

SmartDispatch Client, is integrated in the same installation disc, you 

need to manually select it during installation.  

3 
SmartDispatch 

Gateway  

As this application, together with the SmartDispatch Server and 

SmartDispatch Client is integrated in the same installation disc, you need 

to manually select it during installation.  

4 
SmartDispatch 

Client  

As this application, together with the SmartDispatch Server and 

SmartDispatch Gateway is integrated in the same installation disc, you 

need to manually select it during installation.   

Note 

The Customer Programming Software and USB driver program (V3.01.01.005 or later) are required 

in case of programming the dispatch station, repeater and radio.  

If you need to use the offline map, you should prepare the MapX5.0 installation package by yourself. 
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2.2 Hardware Requirements  
The following table lists the required hardware.  

Hardware  Requirement  

SmartDispatch 

Server  

 CPU: 2.0GHz or above (dual-core)  

 Free disk space: 500GB or above (subject to the actual requirements)  

 Memory: 2.0G or above  

 Operating system: Windows Server 2008, Windows XP SP3 or later, 

Windows 7 SP1 or later (32-bit or 64-bit)  

 Database: MS SQL SERVER 2005 or MS SQL SERVER 2008 

SmartDispatch 

Gateway  

 CPU: 2.0GHz or above (dual-core)  

 Free disk space: 500MB or above  

 Memory: 2.0G or above  

 Operating system: Windows XP SP3 or later, Windows 7 SP1 or later 

(32-bit or 64-bit)  

 Sound card: single-channel sound card or multi-channel sound card.    

 Network interface card: 10/100Mbps or above   

SmartDispatch 

Client  

 CPU: 2.0GHz or above (dual-core)  

 Free disk space: 500MB or above  

 Memory: 2.0G or above  

 Operating system: Windows XP SP3 or later, Windows 7 SP1 or later 

(32-bit or 64-bit)  

 Sound card: single-channel sound card or multi-channel sound card.   

 Video card: general video card or special video card. The former is used to 

view the information on one monitor, while the latter can allow you to view 

the information on different monitors simultaneously.   

 Network interface card: 10/100Mbps or above   

Dispatch station   Firmware Version: VV6.05.xx.xxx or later.  

Repeater Firmware Version: V5.05.xx.xxx or later.  

Radio  Firmware Version: V5.05.xx.xxx or later.   
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Caution  

In Windows 7, you must activate the administrator account first. To install a software program, 

right-click the corresponding installer and select “Run as administrator”.   

2.3 Checking the Edition of the Operating System  
Before you install the SmartDispatch, you need to check whether your operating system meets the 

following requirements:  

Windows XP: SP3 or later     

Windows 7: SP1 or later    

Windows XP  

Right-click “My Computer” and select “Properties” to check the current edition.  

 

Windows 7  

Go to “Control Panel -> System and Security -> System” to check the current edition.  
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3. Installation Flow  
The following figure shows the SmartDispatch installation process.   
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4. Installation Procedures   
The whole installation process except the database installation may take 10 minutes. After you install the 

SmartDispatch, you should verify whether the installation is successful.  

4.1 Activating the Administrator Account  
As the administrator account in Windows 7 is disabled by default, you must activate it prior to installation. 

The procedures are as follows:  

Step 1 Go to “C:\windows\System32”  

Step 2 Find the “cmd.exe” file.  

Step 3 Right-click this file to select “Run as administrator”.  

Step 4 Type “net user administrator /active:yes” in the command prompt.  

Step 5 Check whether the command is run successfully. If yes, log out of the operating system.  

Step 6 Do use the administrator account to log in to the operating system again.  

4.2 Installing the Database (MSSQL SERVER 2005 or MSSQL 
SERVER 2008)  
The installation disc contains the free Microsoft SQL SERVER 2005 Express and Microsoft SQL 

SERVER 2008 Express. You just need to select an appropriate one and install it. For details, see 4.2.1 

Installing and Configuring the Microsoft SQL SERVER 2008 Express or 4.2.2 Installing and Configuring 

the Microsoft SQL SERVER 2005 Express. If you do not obtain this installation disc, you can go to the 

following website to download the database you need.  

Note 

 The “X64” in the file name as shown in the following figures indicates that the installation file is 

applicable to the 64-bit operating system.   

 The installation windows in the manual are for your reference only.  

 MSSQL Server 2005 Express Edition: 

http://www.microsoft.com/en-us/download/details.aspx?id=21844 

http://www.microsoft.com/en-us/download/details.aspx?id=21844
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 Microsoft SQL Server Management Studio Express: 

http://www.microsoft.com/en-us/download/details.aspx?id=8961 

 

 MSSQL Server 2008 Express: 

http://www.microsoft.com/en-us/download/details.aspx?id=1695 

 

It is highly recommended to install the database and SmartDispatch Server on the same computer. 

http://www.microsoft.com/en-us/download/details.aspx?id=8961
http://www.microsoft.com/en-us/download/details.aspx?id=1695
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4.2.1 Installing and Configuring the Microsoft SQL SERVER 2008 
Express  
Installing the Microsoft SQL SERVER 2008 Express   
Requirement  

Before installation, you must have the administrative privileges, and the following tasks have been done.  

 The Microsoft .Net Framework 3.5 SP1 is installed properly in Windows XP.  

 The Windows Installer 4.5 is installed properly.  

 The Windows PowerShell 1.0 is installed properly.   

Procedure  

Note 

The Microsoft SQL SERVER 2008 R2 Express Edition is available in the installation disc. If this 

database cannot meet your requirement, you need to prepare your own database by yourself. 

Step 1 Open the setup file “Microsoft SQL Server 2008 R2 Express Edition”.  

Step 2 Click “New installation or add features to an existing installation” in the “Installation” interface. 

 

Step 3 Select “I accept the license terms” and click “Next”.  

http://go.microsoft.com/fwlink/?LinkId=120550
http://go.microsoft.com/fwlink/?LinkId=123422
http://go.microsoft.com/fwlink/?LinkId=120552
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Step 4 Click “Select All” and specify the installation directory. Then click “Next”.  
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Step 5 Specify the installation directory in “Instance root directory” and leave other settings at their 

default values. Then click “Next”.  

 

Step 6 Set “Account Name” to “NT AUTHORITY\SYSTEM” and click “Next”.  
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Step 7 Select “Mixed Mode”, enter the password (e.g. 123456) for login to the SQL Server and click 

“Next”.  

Note 

 If there is no user in the “Specify SQL Server Administrators”, click “Add Current User”.  

 If the security settings of the operating system have complexity requirements on the password, make 

sure the password is complex enough.  

 Set the password and keep it properly for further configuration.  
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Step 8 Click “Next”.  

 

Step 9 Click “Close” to finish the installation.  
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Post-installation Tasks   

Step 1 Click the  icon in the taskbar and choose “All Programs -> Microsoft SQL Server 2008 R2 -> 

SQL Server Management Studio”.  

Step 2 Set the following parameters according to the settings specified in 4.2.1 Installing and 

Configuring the Microsoft SQL SERVER 2008 Express.   

Set “Authentication” to “SQL Server Authentication” and “Login” to “sa” respectively, and enter 

the password as set during the SQL Server installation.  
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Parameter  Description  Example  

Server name 
Sets the database name. It consists of the 

computer name and database instance name.  
HH22222\SQLEXPRESS 

Authentication Sets the authentication mode.   SQL Server Authentication 

Login 
Sets the database account. Be sure to enter 

“sa” in this field.   
sa 

Password 
Enters the database password that was set 

during the SQL Server installation.  
123456 

 

Step 3 Click “Connect”. The successful connection indicates that the Microsoft SQL Server 2008 

Express is installed properly.   

 

Configuring the Microsoft SQL SERVER 2008 Express  

Step 1 Go to “Start -> All Programs -> Microsoft SQL Server 2008 -> Configuration Tools -> SQL 

Server Configuration Manager”. Click the  icon on the taskbar and choose “All Programs -> 

Microsoft SQL Server 2008 R2 -> Configuration Tools -> SQL Server Configuration Manager”.  



SmartDispatch Installation Guide Installation Procedures 

 

17 

 

Step 2 Go to “SQL Server Network Configuration -> Protocols for SQLEXPRESS”.  

As the database instance name is SQLEXPRESS, the “Protocols for SQLEXPRESS” is 

available.  

 

Step 3 Double-click “TCP/IP” and set “Enabled” to “Yes”.  
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Step 4 Click the “IP Address” tab and set “Enabled” to “Yes”. Then set “TCP Port” to “1433” under the 

“IP All”. Finally click “OK”.  

In general, the database port is “1433”, and will be used later. If there is another database in the 

operating system, it is required to change this port.  

 

Step 5 Click “OK”.  



SmartDispatch Installation Guide Installation Procedures 

 

19 

 

Step 6 Double-click “Named Pipes” and set “Enabled” to “Yes”. Finally click “OK”. 

 

Step 7 Click “OK”.  

 

Step 8 Select “SQL Server Services” and right-click “SQL Server (SQLEXPRESS)” to select “Restart”.  

You must restart the database service to make your changes take effect.  
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Note 

The database instance name is “SQLEXPRESS” in this manual.  

 

4.2.2 Installing and Configuring the Microsoft SQL SERVER 2005 
Express  
As the Microsoft .NET Framework 2.0 is not available in the installation package, you need to download 

it from the Microsoft website and install it before installing the Microsoft SQL Server 2005 Express.  

http://www.microsoft.com/zh-cn/download/details.aspx?id=21844  

When you install the Microsoft SQL SERVER 2005 Express, you need to use the following files:  

 SQLEXPR_SP4.exe: Microsoft SQL SERVER 2005 Express 

 SQLServer2005_SSMSEE.msi: Microsoft SQL Server Management Studio Express 

Installing and Microsoft SQL SERVER 2005 Express  

Step 1 Double-click “SQLEXPR_SP4.EXE”.  

Step 2 Tick the checkbox “I accept the licensing terms and conditions” and click “Next”.  

http://www.microsoft.com/zh-cn/download/details.aspx?id=21844
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Step 3 Click “Next”.  

 

Step 4 Click “Next”.  
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Step 5 Click “Next”.  

 

Step 6 Enter your information and click “Next”.   
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Step 7 Specify the installation directory and click “Next”.  

 

Step 8 Select “Mixed Mode” and create the password (e.g. 123456), and then click “Next”.  

This password is the system administrator password.  
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Step 9 Select “Enable User Instances” and click “Next”.  

  

Step 10 Click “Next”.  



SmartDispatch Installation Guide Installation Procedures 

 

25 

  

Step 11 Click “Install”.  

  

Step 12 Click “Next” after the installation is complete.  
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Check whether all selected components are installed successfully. If yes, it indicates that the 

Microsoft SQL Server 2005 Express is installed properly.  

  

Step 13 Click “Finish” to complete the installation. 

  

Installing the Microsoft SQL Server Management Studio Express  

Step 1 Double-click “SQLServer2005_SSMSEE.msi”.  
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Step 2 Click “Next”.  

  

Step 3 Tick the check box “I accept the terms in the license agreement” and click “Next”.  

  

Step 4 Enter your information and click “Next”.   
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Step 5 Click “Next”.   

  

Step 6 Click “Install”.  
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Step 7 Click “Finish” to complete the Microsoft SQL Server Management Studio Express installation.   

  

Post-installation Tasks   

Step 1 Go to “Start -> All Programs -> Microsoft SQL Server 2005 -> SQL Server Management Studio 

Express”.   
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Step 2 Set “Authentication” to “SQL Server Authentication”, “Login” to “sa” and “Password” to “123456” 

respectively.  

  

Parameter  Description  Example  

Server name 

Sets the database name. It consists of 

the computer name and database 

instance name.  

X09235D\SQLEXPRESS 

Authentication Sets the authentication mode.   SQL Server Authentication 

Login 
Sets the database account. Be sure to 

enter “sa” in this field.   
sa 

Password Sets the database password.  123456 

Step 3 Click “Connect”. The successful connection indicates that the Microsoft SQL Server 

Management Studio is installed properly.   
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Configuring the Microsoft SQL SERVER 2005 Express  

Step 1 Go to “Start -> All Programs -> Microsoft SQL Server 2005 -> Configuration Tools -> SQL 

Server Configuration Manager”.   

 

Step 2 Go to “SQL Server 2005 Network Configuration -> Protocols for SQLEXPRESS”.  

The database name (e.g. SQLEXPRESS) is subject to the actual conditions.  
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Step 3 Double-click “TCP/IP” and set “Enabled” to “Yes”.  

 

Step 4 Click the “IP Address” tab and set “Enabled” to “Yes”. Then set the “TCP Port” to “1433” under 

the “IP All”.  

In general, the database port is “1433”, and will be used later. If there is another database in the 

operating system, it is required to change this port.   
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Step 5 Click “OK” and the dialog box appears. Then click “OK”. 

Step 6 Double-click “Names Pipes” and set “Enabled” to “Yes”.  
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Step 7 Click “OK”.   

Step 8 Select “SQL Server Services” and right-click “SQL Server (SQLEXPRESS)” to select “Restart”.   

 

4.3 Installing the Customer Programming Software  
Make sure that you get the appropriate Customer Programming Software (V6.05.xx.xxx or later). To 

install this software, see its online Help. 
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4.4 Installing the USB Driver Program  
Make sure that you get the appropriate USB driver program (V5.30.41.0 or later). To install this program, 

see its online Help. 

4.5 Installing the SmartDispatch Components  
As the installation disc contains all software components including the SmartDispatch Server, 

SmartDispatch Gateway and SmartDispatch Client, you need to manually select the appropriate one 

during installation. The default license, only covering five radios, is integrated in the SmartDispatch 

software and good for 60 days from the date of installation. If the default license has expired or you need 

a license to cover more radios, you must apply for it. For more information, see 5.2 Applying for a 

License. 

SmartDispatch can be installed via clean installation or upgrade installation. 

4.5.1 Clean Installation 

Caution  

During installation, the installation windows of the Microsoft Visual C++ 2008, Microsoft Visual C++ 

2010, Microsoft SQL Server Native Client and Microsoft .NET Framework 4 programs may appear. If 

these programs already exist in the operating system, the relevant installation window may not 

appear or the repair window may appear.   

Step 1 Double-click the setup file.  

Step 2 Select the language and click “OK”.  

 

Step 3 Tick the checkbox “I accept the terms of the license agreement” and click “Next”.  
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Step 4 Click “Next”.  

 

Step 5 Enter your information and click “Next”.   
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Step 6 Select the software component to be installed and click “Next”. The following describes the 

procedures for installing the SmartDispatch Client, SmartDispatch Gateway and SmartDispatch 

Server on the same computer.  

Caution  
 Make sure that your computer is not in the power saving mode; otherwise, the 

SmartDispatch service will be stopped, resulting in system malfunctions.  

 You can install all SmartDispatch software components on the same computer or on 

different computers respectively, on the basis of your actual needs.  
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Step 7 Specify the installation directory and click “Next”.  

 

Step 8 Verify the installation information and click “Next”.  
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Step 9 Click “Next”.  

If you install the SmartDispatch for the first time, the “Microsoft Visual C++ 2008 Redistributable 

Setup” window will appear; otherwise, the relevant installation window may not appear or the 

repair window may appear.  

  

Step 10 Tick the checkbox “I have read and accept the license terms” and click “Install”.  
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Step 11 Click “Finish” to complete the Microsoft Visual C++ 2008 installation.  

  

Step 12 Tick the checkbox “I have read and accept the license terms” and click “Install”.  
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If you install the SmartDispatch for the first time, the “Microsoft Visual C++ 2010 x86 

Redistributable Setup” window will appear; otherwise, the relevant installation window may not 

appear or the repair window may appear.   

 

Step 13 Click “Finish” to complete the Microsoft Visual C++ 2010 x 86 installation.   
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Step 14 Click “Next”.  

If you install the SmartDispatch for the first time, the “Microsoft SQL Server Native Client” 

window will appear. 
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Step 15 Tick the check box “I accept the terms in the license agreement” and click “Next”.  

 

Step 16 Enter your information and click “Next”. 
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Step 17 Click “Next”.  

 

Step 18 Click “Install”.  
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Step 19 Click “Finish”.   

 

Step 20 Tick the checkbox “I have read and accept the license terms” and click “Install”.  

The “Microsoft .NET Framework 4 Setup” window appears at this time. Otherwise, the relevant 

installation window may not appear or the repair window may appear.  



Installation Procedures SmartDispatch Installation Guide 

 

46 

Note 
The “Microsoft .NET Framework 4 Setup” window only appears in the process of installing the 

SmartDispatch Client.  

 

Step 21 Click “Finish”.  
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Step 22 Click “Finish” to complete the SmartDispatch installation. 

 

Step 23 Restart the operating system to activate the Microsoft .NET Framework. Otherwise, you can not 

open the SmartDispatch Client. 
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4.5.2 Upgrade Installation 
   

Step 1 Double-click the setup file.  

Step 3 Select the language and click “OK”.  

 

Step 4 Select “I accept the terms of the license agreement” and click “Next”.  

 

Step 5 Click “Yes” in the dialog box which appears upon detection of an earlier version of 

SmartDispatch. 
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Step 6 Click “OK”.  

 

Step 7 Click “Finish” to complete uninstallation of the earlier version of SmartDispatch. 

 

Step 8 Click “Next”.  
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Step 9 Enter your information and click “Next”.  
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Step 10 Select the software component to be installed. The following describes the procedures for 

installing the SmartDispatch Client, SmartDispatch Gateway and SmartDispatch Server on the 

same computer. 

Caution 
 Make sure that your computer is not in the power saving mode; otherwise, the SmartDispatch 

service will be stopped, resulting in system malfunctions.    

 You can install all SmartDispatch software components on the same computer or on different 

computers respectively, on the basis of your actual needs. 
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Step 11 Specify the installation directory and click “Next”.  

 

Step 12 Confirm the installation information and click “Next”.  
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Step 13 Click “Finish” to finish the SmartDispatch installation.  

  

4.6 Post-installation Tasks   
If SmartDispatch is installed properly, you can log in to the SmartDispatch Client and open the console.  
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4.6.1 Checking the SmartDispatch Server  
Context  

After the SmartDispatch Server has been installed properly, both the “SmartDispatch Server Console” 

icon and “SmartDispatch Server Config Tool” icon will appear on the desktop.  Their functions are 

specified as below:   

Caution  
Make sure that the database has been installed and configured properly before check. 

 SmartDispatch Server Console: displays all information involving the SmartDispatch Client, 

SmartDispatch Gateway, dispatch station, plug-in, statistics and log.   

 SmartDispatch Server Config Tool: configures the port, audio codecs, database, etc.  

In the SmartDispatch Server Console, the server will automatically detect whether all plug-ins are loaded 

properly. After the license is imported properly and the database is connected properly, the icon  will 

appear in the “Plug-in” tab upon starting the console service.   

Requirement 

Both the database and SmartDispatch Server are installed on the same computer.  

The database has been installed and configured properly. 

Procedure  

Step 1 Right-click “SmartDispatch Server Config Tool” on the desktop and select “Run as 

administrator”.  

Step 2 Click “Database Settings” and modify the account and password.  
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Parameter  Description  Example  

Server IP  

Sets the name of the database server (e.g. 

PC-201005131440\SQLEXPRESS).  

If there is only one database instance in the 

computer, you can enter the IP address in this field.  

127.0.0.1 

Alias  
Sets the instance name of the database. The default 

alias is “RDS”.  
RDS 

Account  
Indicates the database account. Be sure to enter “sa” 

in this field.   
sa 

Password  
Sets the password specified during database 

installation.  
123456 
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Step 3 Import or update the database. 

 If you want to use a brand new database, click “Database Import”.   

 If you want to retain existing data of the old database, click “Database Update”.   

Caution 
Make sure you click “Database Update” if you want to retain existing data of the old 
database. Otherwise, the existing data may be damaged or lost. 

Step 4 Click “Connection Test”. After successful connection, the relevant dialog box will appear. Then 

click “OK” in the dialog box.   
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Step 5 Click “Save and Start”. 

Step 6 Right-click the “SmartDispatch Server Console” icon on the desktop and select “Run as 

administrator”, and then right-click the icon  in the taskbar and select “Display”. The 

following window will appear.  

 

Step 7 Click the “Plug-in” tab.  
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If the SmartDispatch Server is installed properly, all plug-ins can be loaded successfully. 

 

4.6.2 Checking the SmartDispatch Gateway   
Context  

After the SmartDispatch Gateway has been installed properly, both the “SmartDispatch Gateway 

Console” icon and “SmartDispatch Gateway Config Tool” icon will appear on the desktop.  Their 

functions are specified as below:   

 SmartDispatch Gateway Console: displays the dispatch station list, server list, statistical information 

and log information.  

 SmartDispatch Gateway Config Tool: configures the IP address and port, audio codecs, dispatch 

station, language, etc.  

Procedure  

Step 1 Right-click “SmartDispatch Gateway Config Tool” on the desktop and select “Run as 

administrator”.  
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Step 2 Click in the blank area of the “Server List” pane, and click “Add” to add a server. 

Caution 
If the SmartDispatch Gateway and SmartDispatch Server are installed on the same computer, you 

can skip the step above.  

 

Step 3 Click “Save and Start”.    

If you make any change in this tab, the button will change from “Start” to “Save and Start”.  

Step 4 Click “Dispatch Station Settings” and add a dispatch station. Then click “Connection Test”.  
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If the connection test is successful, it indicates that the dispatch station can communicate with 

the SmartDispatch Gateway properly. 

Caution  

The dispatch station to be added must be programmed properly. For more information, see 

Hytera SmartDispatch-Net Configuration Guide.  

 

Parameter  Description  Example  

Alias Sets the alias of the dispatch station.  MR7 

Pseudo ID 

Sets the pseudo ID. Such ID in the same 

pseudo trunking must be identical. If this 

parameter is set to 0, it means that the 

Pseudo Trunking feature is not enabled for 

the dispatch station.  

Caution  
To activate the Pseudo Trunking feature, 

there must be two dispatch stations in 

the same group but on different slots.  

0 

Virtual IP  

Sets the virtual IP of the dispatch station. It 

consists of four sections. The first three 

sections are the same as those of the IP 

address defined in the Customer 

192.168.87.2 
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Parameter  Description  Example  

Programming Software, while the last 

section is one greater than that of the IP 

address.  

For example, if the dispatch station IP is 

192.168.87.1, the virtual IP should be 

192.168.87.2.  

Connection Test  
Tests whether the dispatch station is 

connected properly.   

 

Enable DS 

Microphone  

Sets whether to activate the microphone.  

If you use the microphone to talk, only the 

voice from the microphone will not be 

recorded. However, the relevant call records 

involving the microphone still exist.  

 

Quick GPS 

 Checked: the dispatch station will only be 

used as the quick GPS data station, 

unable to transmit the audio signal. 

Then you need to set another dispatch 

station for audio transmission. Only 

when the dispatch station is used to 

transmit quick GPS data can the 

SmartDispatch distinguish the quick 

and normal GPS data.  

 Unchecked: the dispatch station will 

transmit both the audio signal and GPS 

data.   

 

GPS Dispatch 

Station   

Sets whether the dispatch station is used to 

transmit the GPS data.  
 

Speaker  
Sets the name of the speaker.  

If the “GPS Dispatch Station” option is 
Speakers (SB 5.1 VX) 
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Parameter  Description  Example  

selected, this option is not available. 

Microphone  

Sets the name of the microphone.   

If the “GPS Dispatch Station” option is 

selected, this option is not available. 

Line-In (SB 5.1 VX) 

Step 5 Click “Repeater Setting”, and click “Add” to add a repeater. Then click “Save” to save your 

settings.  

 



SmartDispatch Installation Guide Installation Procedures 

 

63 

 

Parameter  Description  Example  

Radio ID  Sets the SSI of the repeater.  92 

Alias  Sets the alias of the repeater.  Repeater3 

IP Site ID  

Sets the ID of the IP Multi-site Connect network. 

SmartDispatch determines which IP Multi-site 

Connect network the repeater belongs to according to 

this ID. The data from the repeater is only transmitted 

within this IP Multi-site Connect network.    

1 

Pseudo ID 

Sets the pseudo ID. If this parameter is set to 0, it 

means that the Pseudo Trunking feature is not 

enabled.  

 

Slot1 Slot 1   

Alias  Sets the alias of the slot.  Slot1 

Subnet ID  

Sets the ID of the subnet consisting of the repeater 

and the radios under that repeater.   

You need to set the subnet ID for the radios under that 

repeater during programming. Please note that the 

subnet ID of the repeater and radios within the same 

21 
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Parameter  Description  Example  

subnet must be identical.   

Quick GPS 

 Checked: the slot can only transfer quick GPS 

data, and another slot is needed to transfer audio 

signal. Only when the slot is used to transmit 

quick GPS data can the SmartDispatch 

distinguish the quick and normal GPS data.  

 Unchecked: the slot will transfer both audio signal 

and GPS data.  

 

GPS Repeater  

If you select this option, the slot is in charge of 

transmitting the GPS data. Otherwise, this slot is used 

to transmit the audio signal.  

 

Local Slot  The slot is only used for local data transmission.    

Encrypt Slot 
This option must be selected if you need to encrypt 

the voices. Be sure to set “RTP Type” to “RTP_SELP”.  
 

RTP Type 
Sets the audio format for transmission. Be sure to set 

it to “RTP_SELP”.  
RTP_SELP 

Slot2 Slot 2.  

Alias  Sets the alias of the slot.  Slot2 

Subnet ID  

Sets the ID of the subnet consisting of the repeater 

and radios.   

You need to set the subnet ID for the radio during 

programming. Please note that the subnet ID of the 

repeater and radios subnet must be identical.   

21 

Quick GPS 

 Checked: the slot can only transfer quick GPS 

data, and another slot is needed to transfer audio 

signal. Only when the slot is used to transmit 

quick GPS data can the SmartDispatch 

distinguish the quick and normal GPS data.  

 Unchecked: the slot will transfer both audio signal 

and GPS data.  
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Parameter  Description  Example  

GPS Repeater  

If you select this option, the slot is in charge of 

transmitting the GPS data. Otherwise, this slot is used 

to transmit the audio signal.  

 

Local Slot  
If you select this option, the slot is only used for local 

data transmission.  
 

Encrypt Slot 
This option must be selected if you need to encrypt 

the voices. Be sure to set “RTP Type” to “RTP_SELP”.  
 

RTP Type 
Sets the audio format for transmission. Be sure to set 

it to “RTP_SELP”.  
RTP_SELP 

Step 6 Open the “SmartDispatch Gateway Console” and click the “Server” tab to check the connection 

between the SmartDispatch Gateway and SmartDispatch Server.  

If the icon  appears, it indicates successful connection between SmartDispatch Gateway 

and SmartDispatch Server.  

 

Step 7 Click the “Dispatch Station” tab to check the connection status of the repeater.  

If the icon  appears, it indicates successful connection between SmartDispatch Gateway 

and repeater. 
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4.6.3 Checking the SmartDispatch Client  
Context  

After the SmartDispatch Client has been installed properly, the “SmartDispatch Client 4.2” icon will 

appear on the desktop.   

Procedure  

Step 1 Right-click “SmartDispatch Client 4.2” on the desktop and select “Run as administrator”. 

 

Step 2 Click “Setting”.  

Step 3 Set all parameters.  
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Both the user name and password for the administrator account are “admin” by default. If the 

SmartDispatch Client is installed properly, you can log in to it successfully. 

Caution 

The server IP must be identical with that in the SmartDispatch Gateway.  

 

The main window appears after successful login.   
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5. Appendix  
5.1 Uninstalling SmartDispatch  
Requirement 

Make sure that the SmartDispatch Server Console and SmartDispatch Gateway Console are not active.    

Procedure  

Step 1 Click the  icon in the taskbar and choose “All Programs -> Hytera -> SmartDispatch 4.2 -> 

Remove SmartDispatch 4.2”.  

Step 2 Select “Remove All” and click “Next”.  

 

Step 3 Click “Yes” in the dialog box. 

  

Step 4 Click “Finish” after the uninstallation is complete.  
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5.2 Applying for a License  
The License is required for normal operations of the SmartDispatch Server and SmartDispatch Gateway.  

When SmartDispatch is bound to the Mac address of PC 

 If the SmartDispatch Server and SmartDispatch Gateway are installed in the same computer, only 

one License is needed. After obtaining the License file, save it to the installation directory of the 

server and the gateway respectively.  

 If the SmartDispatch Server and SmartDispatch Gateway are installed in different computers, you will 

need to apply for different Licenses according to the computer machine IDs. Save the License files to 

the corresponding installation directories.  

When SmartDispatch is bound to the SN of the USB dongle 

You only need to apply for a License according to the serial number (SN) of the USB dongle. See the 

following steps for the application. 

Step 1 Click the  icon in the taskbar and choose “All Programs -> Hytera -> SmartDispatch 4.2 -> 

Serial Number Tool”.  
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Step 2 Generate a serial number, and send it to your dealer to apply for the License.  

 If the SmartDispatch is bound to the Mac address of the computer, click “MAC”.  

 If the SmartDispatch is bound to the serial number of the USB dongle, click “Dog SN”.  



2014
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